
Требования типографии «МТК пресс» к файлам для печати

Электронные носители
CD-R, CD-RW, DVD, USB-flash drive

Электронные носители CD и DVD с файлами предоставленными заказчиком не возвращаются, а хранятся 
у исполнителя на случай возникновения спорных ситуаций. Все электронные носители, принимаемые 
в типографии, проверяются антивирусной программой, что занимает определённое время. Поэтому мы 
настоятельно рекомендуем перед сдачей в типографию удалять с носителей все лишние файлы.

Форматы файлов
Форматы файлов (в порядке предпочтительности):

•	 Adobe	PDF
Просим принять во внимание, что в рабочем потоке вывода на печать в нашей типографии использу-
ется только формат PDF. Макет, полученный в любом другом формате, мы вынуждены преобразовы-
вать в PDF. Для проверки результатов такого преобразования может потребоваться дополнительное 
согласование, что увеличит время выполнения вашего заказа и потребует дополнительной работы. 
Исходя из этого, настоятельно рекомендуем сдавать макет в типографию именно в виде файла форма-
та PDF, подготовленного в соответствии с нашими рекомендациями.

•	 EPS
•	 TIFF
•	 AI (Adobe Illustrator до ver. CS5.1)

•	 CDR (Corel DRAW до ver. 14)

•	 Adobe	InDesign до ver. CS5.5

Просим в названии присылаемых файлов не использовать кириллицу, т. к. кириллические символы не 
поддерживаются некоторыми программами, используемыми при допечатной подготовке.

Общие замечания по вёрстке

Публикации с количеством полос более 2 принимаются только в формате Adobe PDF. Недопустимо 
предоставлять для таких публикаций отдельные файлы на каждую полосу. 

Для передачи файлов многополосных публикаций через FTP-сервер может понадобиться их разделение 
на части – свяжитесь с нами для уточнения условий передачи.

Все объекты в файлах должны быть представлены в цветовых моделях CMYK (32-bit), Grayscale (8-bit), 
Bitmap. 

Разрешение и компрессия растровых изображений
Все растровые графические объекты должны быть предоставлены с разрешением 300 - 350 ppi (CMYK, 
Grayscale) с ZIP компрессией, Bitmap с разрешением 600 - 2540 ppi с компрессией CCITT Group 4. 

Мы не берёмся давать прогнозы о качестве печати изображений, имеющих разрешение менее рекомен-
дованного.

Использование избыточно высокого (более 350 ppi) разрешения растровых изображений не повышает 
качество печати, затрудняет проверку и обработку макетов. Просим выполнять контроль и (при необхо-
димости) понижение разрешения до разумного уровня. 

JPEG компрессия может быть использована только с параметром «Image Quality - Maximum». LZW ком-
прессия недопустима.  Необходимо перед передачей файлов в типографию выполнить для всех «под-
линкованных» растровых изображений слияние слоёв. Недопустимо сохранять в передаваемых растро-
вых файлах текстовые слои и эффекты.



Total Ink Limit
Совершенно необходимо отслеживать суммарную плотность красок C+M+Y+K  (Total Ink). Максимально 
допустимое значение для мелованной бумаги - 305, для немелованной - 280.  

Как наиболее корректный способ уменьшения суммарной плотности красок мы рекомендуем приме-
нение специальных цветовых профилей ICC. Подробнее о суммарной плотности красок – в Приложе-
нии Total Ink Limit.

Применение атрибута Overprint и «составного чёрного»
Весь чёрный текст (за исключением очень крупных заголовков), мелкие чёрные объекты и линии долж-
ны быть заданы цветом CMYK 0-0-0-100 или Gray 0% и иметь атрибут Overprint. Применение «составного 
чёрного» цвета (например:  сyan-70, magenta-70, yellow-60, black-80) для таких объектов недопустимо.

Для крупных чёрных объектов (например - фоновых заливок) желательно применение «глубокого чёр-
ного», например: сyan-40, magenta-30, yellow-30, black-100.

Назначение атрибута Overprint для белых и светлых объектов недопустимо. Для контроля результатов 
обработки атрибута Overprint в ваших макетах необходимо включать опции отображения Overprint в на-
стройках View в вашей рабочей программе.

Толщина линий и размер шрифтов
•	 используйте линии толщиной 0,25 pt (0,088 мм) и более. Линии толщиной менее чем четверть пункта, 

выглядят на экране монитора и распечатках с лазерных принтеров значительно более плотными, чем 
они окажутся на самом деле. При ипользовании «составного» (2 и более цветов) цвета линий и белых 
линий на «составном» фоне (выворотка) толщина линии должна быть не менее 0,2 мм.

•	 не используйте линии с атрибутом Hairline (Волосяная линия). Разные программы вёрстки и рисова-
ния по-разному определяют толщину линии с атрибутом Hairline. Некоторые программы определяют 
Hairline линию как линию тощиной 0,25 pt, а некоторые как линию минимально возможной толщины, 
воспроизводимой выводным устройством. Минимально возможная толщина линии, воспроизводи-
мая нашим выводным устройством, может оказаться неожиданно малой для Вас.

•	 ограничение для размера шрифтов при ипользовании «составного» (2 и более цветов) цветного тек-
ста и белого текста на «составном» фоне (выворотка): толщина самого тонкого длящегося элемента 
символа не должна быть менее 0,2 мм. Отступление от этого правила возможно только после допол-
нительного обсуждения со специалистами типографии.

Обрезной формат страницы
Для изображений, завёрстанных “под обрез”, требуется добавлять припуск (он же – выпуск, bleed) на рез-
ку - в нашей типографии 2,0 мм на сторону (например для изображения с послеобрезными размерами 
100х70 мм. дообрезной размер должен быть 104х74 мм).

Надписи и значимые изображения (например – логотипы, схемы и т. п.) не должны быть размещены бли-
же 5 мм. от обрезного края полосы.

http://mtkpress.ru/files/file/ECI_Offset_2009.rar
http://mtkpress.ru/files/file/TIL_appendix_2013.zip


При вёрстке многостраничных изданий, для которых предполагается переплёт на клеевой машине (КБС), 
просим учесть:

•	 5 мм. полос, составляющих первый и последний разворот, со стороны корешкового поля «уйдут» под 
проклейку переплёта (см. схему ниже);

•	 все значимые элементы на полосах нельзя помещать на расстоянии менее 10 мм. от края полосы со 
стороны корешка.

•	 недопустимо использование совмещаемых в развороте значимых объектов и портретов.



Управление цветом
Печатный процесс в нашей типографии ориентирован на соблюдение требований стандарта печати ISO 
12647-2:2004.

Во избежание недоразумений просим во всех программах, в которых вы готовите файлы, отключать 
функцию внедрения цветового профиля. При обработке ваших файлов в нашей типографии  (формиро-
вании печатных заданий) управление цветом отключается, и все внедрённые профили будут проигнори-
рованы. Таким образом, все объекты в сдаваемых в печать файлах должны быть представлены в цвето-
вом пространстве Device CMYK или Device Grayscale.

Несоблюдение этого требования может привести к значительным расхождениям между изображением 
на экране вашего монитора и изображением, выводимым в печать. Поэтому мы рекомендуем внима-
тельно относиться к настройкам управления цветом (в т.ч. и экранного отображения) в используемых 
вами программах: например, при назначении в качестве рабочего цветового пространства Generic CMYK 
(по умолчанию в Corel DRAW) отображение цветов CMYK на экране совершенно не соответствует цве-
там, которые будут напечатаны реальной офсетной машиной.

Для просмотра цвета на экране монитора (монитор должен быть аппаратно откалиброван) лучше 
всего подходит режим «экранной цветопробы» в Photoshop: View>Proof Setup; профиль ISO coated_v2 
(ECI) как раз и покажет, как данное изображение будет напечатано на мелованой бумаге согласно стан-
дарту ISO 12647-2:2004. 

Цветные принтеры:

•	 несмотря на то, что современные персональные цветные принтеры обеспечивают великолепную 
резкость деталей и яркость цветов, ни один из них без соответствующего программного обеспече-
ния не в состоянии воспроизвести тиражный цвет;

•	 для оценки тиражного цвета используйте книжки образцовых оттисков триадных цветов PANTONE 
Process;

•	 если вы неуверенны в том, как будут выглядеть цвета вашего издания в тираже, особенно если от-
тенок цвета принципиально важен (например, цвет логотипа) – мы можем изготовить по вашему 
заказу контрактную цветопробу, максимально близко имитирующую тиражный цвет в соответствии 
со стандартом ISO 12647-7:2007. Возможность изготовления цветопробы для печати на нестандарт-
ной бумаге или картоне обсуждается дополнительно.

Определение и использование дополнительных цветов
•	 используйте дополнительные цвета Spot Color (смесевые цвета и цвета библиотек PANTONE) только в 

том случае, если действительно предполагается печать дополнительными красками. Во всех осталь-
ных случаях дополнительные цвета должны быть переведены в  CMYK (Process Color). Исключением 
может быть использование Spot Color для обозначения дополнительных послепечатных операций 
(контур вырубки, лак и т. п.);

•	 при использовании книжки образцовых оттисков («веера») цветов PANTONE удостоверьтесь в том, 

http://mtkpress.ru/files/file/ECI_Offset_2009.rar
http://yandex.ru/clck/jsredir?from=yandex.ru%3Byandsearch%3Bweb%3B%3B&text=ISO%2012647-2%3A2004&uuid=&state=AiuY0DBWFJ4ePaEse6rgeAjgs2pI3DW99KUdgowt9XvoT-twMUKrgMrTK8sQptwAmYP1XIvjXoQu2zeGVUYD3xNoKzRCp5TvqKu6f_9wAb2tZ48rMmoTxQZikES4abresDU1IdPS0W9e6B2yvL-UsxHFP2ZFDTH3DsGXo-m-hZoCdZjcRozc7lrZNPQIDvp5fbfwZZDD8OA&data=UlNrNmk5WktYejR0eWJFYk1LdmtxaE1KVnZENkJZVG1ucGptM0VnVlNoY2NtaDdzMkxsMUNjRW1laWNNT3dJeTFSbHhOZTE1cG5reVJUbGZhaGpLd1R4eVJ6M0VhVXB3UlI2VUNIbkRKM05YdTVqLVJkeUJyWllzankzVkJYNDE&b64e=2&sign=ec306125caf9e5801a8740b3d6880e2e&keyno=0&l10n=ru&mc=4.103909910282364
http://yandex.ru/clck/jsredir?from=yandex.ru%3Byandsearch%3Bweb%3B%3B&text=ISO%2012647-7%3A2007&uuid=&state=AiuY0DBWFJ4ePaEse6rgeAjgs2pI3DW99KUdgowt9XsltfjMh8My-6YD9V05SPiyH_s82TMKBsSw0swasMtBaQhdJ6rSnCNuicGiOeTJ_YgdY53z9dVXDEi3Xmf5RqPUisg8A3GQ9FeOZtAzclISFwtGVwoZhNn7lPj0xD8sFn3MvzO6Z_N9RK836HBwbPicjo_wOEH_QUE&data=UlNrNmk5WktYejR0eWJFYk1LdmtxcXlGY2UxaVNublM1OXJsUmdhaThSTHY5YTAzNmotSkFuWmpUUU9xUVJSV2gyVmQtWjYzNWp0UjlNbDRpWk1LTHpQOExwcE9jMnl3WTZjY0N0UHlyQ1k0ZE4yMDBKQUhLNmlISlJlTGhWRW9XZllybUlOQk9XUFhCRGFoV0lOcmliSy1lRUFqa2Fqa1JmLW1uczJLZUNZ&b64e=2&sign=e98247ddca81679554764ec98b585ffe&keyno=0&l10n=ru&mc=6.14925237741745


что вы используете веер нужной цветовой модели, соответствующий предполагаемой тиражной 
бумаге (матовой или глянцевой). Удостоверьтесь в том, что в программе вёрстки или рисования вы 
используете нужную программную библиотеку PANTONE.

О контурах вырубных штампов (штанц-форм) и выборочном лакировании
Все контуры вырубных штампов (штанц-форм) и области выборочного лакирования принимаются только 
в векторном формате. При создании объектов, описывающих участки лакирования, просим не исполь-
зовать обводку. Контур штампа должен быть выполнен только (!) линиями (обводка\stroke\outline). Все 
элементы, описывающие контур вырубки и биговки, участки лакирования и т.п., необходимо помещать 
непосредственно в макет, предоставляемый для печати. Заливка или обводка этих элементов выполня-
ется Spot-цветом (например - любым цветом из библиотек PANTONE) с атрибутом Overprint On. Название 
этого Spot-цвета не должно совпадать с названиями цветов  используемых в данном макете для печати. 
Изображения завёрстанные “под обрез” при вырубке штанцформой должны иметь припуски 2 мм.

Трэппинг
Не изменяйте значений трэппинга, существующих по умолчанию после инсталляции пакета вёрстки, 
если только вы не представляете себе совершенно точно, что вы делаете.

 
 

Требования к файлам Adobe PDF
•	 Все используемые шрифты должны быть внедрены в файл.

•	 Все изображения внедрены в файл без функции OPI. 

•	 Должен быть указан обрезной формат страницы при помощи параметра Trim Box.

Для многополосных изданий:

•	 Страницы в файле должны следовать в том же порядке и ориентации, что и в готовом издании. 

•	 Если в издании планируются пустые страницы, то и в файле они должны присутствовать. 

•	 Нумерация страниц в файле должна соответствовать нумерации в издании, не нужно выполнять 
спуск полос – мы сделаем это сами.

Настройки для записи в PDF вы можете просмотреть в Приложении Adobe PDF.

Требования к файлам EPS
Графические объекты в EPS-файлах должны быть внедрены (Embeded), шрифты переведены в кривые. 
При записи EPS-файла необходимо, чтобы размер страницы соответствовал обрезному формату изделия, 
припуски определены атрибутом Bleeds.

Требования к файлам TIFF
Убедитесь, в Photoshop’е, что файл не содержит в себе никаких дополнительных слоёв Layers, каналов 
Channels (кроме Multichannels) и путей Paths.  При сохранении из Photoshop не внедряйте цветовой про-
филь.

http://mtkpress.ru/files/file/Adobe%20PDF.rar


Недопустимо использование «многостраничных» tiff-файлов.

Adobe InDesign до ver. CS5.5
В некоторых случаях (и только по предварительной договорённости!) возможно предоставление много-
полосных макетов в программе вёрстки Adobe InDesign (до ver. CS5.5). В этом случае к файлу вёрстки 
должны быть приложены:

•	 все используемые шрифты;

•	 файлы подлинкованных изображений;

•	 дополнительно используемые при вёрстке плагины (например, сторонние плагины переноса в 
InDesign);

•	 preview в формате PDF или распечатка.

Если вы верстаете в других программах - позвоните и проконсультируйтесь с нами.

Файлы Corel DRAW до ver. 14, Adobe Illustrator до ver. CS5.1*:
•	 все шрифты должны быть переведены в кривые; 

•	 растровые графические объекты  должны быть внедрены (Embeded);

•	 все эффекты в (тени, прозрачности и т. п.) должны быть отрастрированы;

•	 Для проверки цветовых моделей, наличия текста  и наличия эффектов используйте в Corel DRAW – 
File>Document Properties, в Adobe Illustrator - Window>Document Info. Проверяйте раздел Graphic 
Objects в Document Properties CorelDraw, параметр Max# of curve points должен быть не более 5000.

* графические редакторы и программы рисования не имеют некоторых важных инструментов для про-
верки готовности файла к печати (например, Total Ink - суммарной плотности красок и т. п.), поэтому мы 
настоятельно рекомендуем использовать в качестве конечного формата PDF-файл. Программа Adobe 
Acrobat Professional, начиная уже с 7ой версии, имеет серьёзные инструменты допечатной подготовки, 
что позволит вам сделать результаты вашей работы более предсказуемыми.

Просим вас внимательно отнестись к соблюдению всех параметров, описанных в данных требовани-
ях, т. к., если это не оговорено дополнительно, мы не обязуемся сообщать заказчику о несоответствиях 
данным требованиям и считаем, что заказчик согласен на печать заказа из предоставленных файлов «как 
есть» под ответственность заказчика.

Ответственность за качество печати из файлов, подготовленных не в соответствии с данны-
ми требованиями, лежит на заказчике.




